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Complete Documentation & Additional Support
Complete documentation, support forums, bugs, etc… can be found at the ModX site: http://modxcms.com/support.html 

What ModX Is and Isn’t?  
· Technically speaking, ModX is a CMS, or “content management system”  
· First this means that anyone can edit their website, right on the internet, without buying any software/tools like FrontPage or Dreamweaver.  

· A  CMS also is a content editor; that is to say that it is designed to let you edit the content of your website, and not the design itself (usually the top, left, and bottom of the page).  This also keeps the maintenance chore very low on your website, saving you or your designer time/money.  

· A CMS is easy to use for the most part, especially to anyone that is already familiar with office software such as Microsoft Word.
· It is also more powerful than a simple website editor in that you are allowed to create many different user accounts, each with their different permissions/responsibilities for maintaining the website.  Many of you will not need that much control.

· ModX is not for people who are unwilling/unable to learn something new, and spend the short time necessary for carefully updating their website.  For this group of people, perhaps hiring a web designer may be a better option. On the other hand, if your website is only one or two pages at most, and it is not important to you to keeping it look professional, then some of this may be irrelevant to you.

The challenge:  All CMS and website editors are notorious for creating very ugly and messy HTML code.  ModX is no exception here, unless you follow these instructions.  Not only is this really bad for search engines, but perhaps more importantly, you may find it difficult to get a real web designer to work on your site, should you ever need to.  Let me explain a little more of why ModX is special in this regards.

Oh, and from now on, if I say website editor/designer, CMS, or ModX, it’s all the same thing. For a comparison that you might better relate to, I can say that I drive a vehicle, specifically a car, specifically a Honda.
CRITICAL! - How to use ModX to avoid messing up your site, and make your life easier; or in other words: Keeping Your Website Organized, Professional, and Up to Date Through What are Called ‘Styles’
Here is the key principle

In good website design, the meaning/words are separate from the design.  In other words, your goal should be to do one thing:  create the words on the page, and not design the colors, styles of the site, which is done by the designer. Whether it’s the line-height of your paragraphs, or changing the color of all your headings, all of this is should have been setup for you by your designer for the most part.  He does this in a file he can control, called the CSS file.  I will explain how this works in detail later.
Why is this so important you ask?  
Part of the problem most websites face, is site consistency and updating.  Let’s say, that across your whole website that you have your font in black, Ariel, but one day you decide to change this to Times New Roman and blue.  So, you go through 20 pages on your website, and pain-stakingly, change the font, one page at a time, one paragraph at a time. Maybe you forget to change a paragraph, or whatever.  Or maybe you decide to make 20 different font types and colors, so your site begins to really look like a coloring book written by 20 different people.
This should never be occur if you use ModX.  Instead, your web designer controls the entire look and feel of your site formatting with the afore  mentioned CSS file.  So, to update your font for your whole site, the web designer would just change this one CSS file, very quickly and easily, and all 20 pages would automatically update for you. So instead of  you spending a few hours  updating your site, he does it in a few minutes.   In fact, usually your siite design is established from the beginning, so it would be quite rare to change something like this unless you were redesigning the whole site. 
Even if you decide you want 3 or 4 different font styles for your site, your web-designer would create these in the CSS file—then you would find these options within the ModX editor—more details later.  By doing this, not only will it save you a ton of time, but it will keep your website looking consistent, professional, easy to maintain, and keep it from looking increasingly worse over time (even help marginally for search engine rankings).  I will show you some actual examples later.
Ultimately, even during the creation of your pages, you will find that you can get more done in less time, and not worry about how to make every page look good.  I can’t  count the number of websites I come across regularly that could really benefit  from using something like ModX
Making the Most of the Manager Interface

When you log in, you will see a lot of things.  For you,  the end user, you will just use the “Site” tab for the most part.  Perhaps the “Reports” may come in handy for you as well.  On the submenu, you don’t really even need these, except for maybe the “Search” if you are having trouble finding a particular page on your site.
The left hand window pane, what is called the “document tree” contains all the pages on your website.  You may find them nested, just like folders and documents on your computer. The icons at that top of that document tree window, if you let your mouse hover over them, will show you what they do.  The “Create New Document” and “Refresh Tree” will be the most useful to many of us.

Right-clicking is one of the most convenient ways to get things done.  What I mean by this is, if you right-click on any of your website documents (in the document tree), you will see a context menu that allows you to edit, duplicate, delete, and do many other things.  
Backing up Your Site before Starting

When in doubt, click on ‘Tools” and then “Backup” to make a backup of your site.  In fact, you probably want to do this often.  Better safe than sorry.
Creating Pages for Your Website

Duplicating a Page to Create a New Page is Often Better and Easier
For the most part, you will save yourself time when creating new pages by simply duplicating an existing page on your website.  It really helps in many ways.  First off, you will know what fields your site is using (I explain “fields” in the next section).  Second, it lets you create a page that uses the exact same layout as other pages on your site, keeping your website coherent and professional looking.  To duplicate a page, just right-click on an existing page from your site, and click “Duplicate.”
Create a New Page


Again, as just mentioned in the previous section, it is almost always easier and faster to simply duplicate an existing page on your site, than it is to create a new one from scratch.  But in this example, I will create my first new page for my website.  
Now, I have a new page ready to go.  There are a lot of options here, but I will show you what they mean, and which ones are most important.  ModX can be customized to do a lot of things with these fields, but I will explain how it works by default for most people.  When in doubt, simply look at another existing page on your site to see which fields are being used.  You may also find the little question mark icons helpful (to the right of each field). 
In summary, you may only need to fill in the Title field as a bare minimum, depending on how your site is setup, and what features of ModX you will be using.  
“Title”  
The title field is used for the title of the page.  You can see a pages title in the blue bar at the top of your browser.  It is also used by search engines as the link name, so it is important to name this well.  Depending on how your ModX was setup, it is possible that the Title will automatically append your website name to all of your pages.  Your web-designer can change this for you.  
Example:  I am going to make a page about my company.  Ok, this is not a good title, but I will put About Our Company.  
“Long Title”
This is a field which may be used in your site template as well, depending on how your web designer setup your site.  The easy way to find out is to fill it in, then check on your site to see if it does anything.  If not, then don’t worry about it.  It is often used to create a nice large heading for the page.  
Example:  I will often just keep this the same as the Title. So I am going to put About Our Company in this field.
‘Description” 
By default, this is just for you to make notes to yourself.  So I will usually leave it empty.  

“Document’s Alias”  
If your site was setup to use ModX’s “Friendly URL’s” feature, then this field gets used for the page name.  Let me explain.  Without the “Friendly URL” feature, the address names on your website will look something like this:   http://mysite.com/index.php?id=999   With the feature enabled,  your pages will have real words and look like this: 

Http://mysite.com/about-our-company.html
To see what I mean, just go over to your website and click on any link.  Then look in the address bar to see which one your site is using.
The friendly URL serves two purposes.  First, for anyone visiting my website, it will be  easier for them to remember the friendly URL, should they want to go directly to that page by typing it into their address bar.   Second, it can improve your search engine rankings.

Important:  This should be ALL in lowercase, and use hyphens to separate words (no spaces, no funny characters like !@#$%^&&*() etc…, no capital letters); otherwise, things might not work well,  or could even  break.  
Again, the alias will probably be similar to, or the same as your Title.

Example:  For this, I am just going to put in the word:  about.  That way, someone can go to my website and just type “about.html” and get to that page.  

As you can see, my Title, Long Description, and Document Alias are all pretty much the same. 
“Link Attribute” 
This is not something most people will use very often, if at all, so I am going to skip this.

“Summary”

Again, mainly just a place to make notes, so I leave this blank.
“Uses Template”
You might find that you have one or more templates, or what we will call designs, for your website.  If you have more than one, then you can choose from it here.  If you want to change thee default template that shows up in here, that can be done under  “Tools” > “Configuration.” 
Example:  I have one template for my homepage, and another for the rest of my site.  You can see that on my homepage, I have an extra column on the left side of my page. My website designer created these templates for me, so these names may be different than yours.
“Menu Title”
If I am using ModX to generate navigational menus on my website, then this field should be used.  It is the text that appears on my menu. So it should be short.
Example: I will put in About Our Company. 

“Menu Index” and “Show in menu”
If I am using ModX generated menus, then I can put in a number here to determine the sort order this appears in the menu. The option “The Show in Menu” lets you decide if you want to have this page show up in the menu at all.

“Document Parent”

Mostly used if you have lots of pages on your site and need to keep things organized by having several folders; or, you are using the ModX generated menus.  If you click the little folder icon, you can change where this page appears in your site structure/hierarchy.  In other words, I can have it show up on a sub-menu of the main menu by assigning it to a parent document.

Recapping, I will always want to fill in the “Title” field.  And as mentioned previously, it is easy to know which fields to uses simply by duplicating, or at least looking at, another page on your website.
The Editor / Toolbar
We highly recommend reading this entire chapter before proceeding.

RULE #1:  Never copy and paste from Microsoft Word (WordPerfect, etc…) into this editor.  
It will slowly degrade your website because these programs add lots of garbage code that makes it near impossible to update/maintain your website. It can easily begin to get corrupted making it impossible to update your website pages.  If you prefer, you may copy it from your word processor into Notepad (for PC’s) first, and then into the editor, but all the formatting (e.g. bolding, italics, underline, etc…) you should apply using the ModX editor.

Easy to use

If you have used a word processor like Microsoft Word, then you will recognize much of this, with some exceptions.  But I do want you to understand that a website is not a Microsoft Word document—a website is much more delicate than that.
Toolbar / Editor

Initially you will notice many familiar icons across the top of the editor toolbar.  Many of these you SHOULD NOT USE—which I will explain shortly.  The most familiar ones, that you will likely use, include thee following:
· Bold, Italics, Underline
· Alignment (left, right, center, justify)

· Cut / Paste

· Bullets (numbered, un-numbered)

· Insert/edit link, image

· Select all, Undo,  Redo

· Insert horizontal ruler / Insert horizontal rule (e.g. a line)

· Insert table.  
I won’t cover all of these in I detail since most are self-explanatory if you have ever used a word processor such as Microsoft Word.  You will also see a “help” icon which also talks about the basic ways to uses the editor.  The first time that you log in, it may take up to a minute to load the editor.
Icons/buttons that you should not use:
Although there are several buttons available, there are many that in our opinion should be avoided, if you want to maintain consistency, and easy updating on your website.  That would include:  
· Font family

· Font size
· Select text color

· Select background color (e.g. highlight)
If you wanted to use a certain font family and font size on your website, you would probably want to limit it to just a few, because if your site had 50 different font styles, and sizes, it would look really messy; but I see this quite often these days, especially when the site has more than one person working on it.  It would also be very hard to update all the fonts if you ever need to.  
In other words, anything that you will repeatedly use on your site should ideally be found in the “Styles” drop-down menu.  This is almost just like using the “Styles and formatting’ tool in Microsoft Word’ except that your web designer can add more styles to that drop-down menu if you need.  

If will also save  hours, or days when you decide to update your website someday because your designer can make a few quick changes, and the whole website will update those styles.  You can learn more about this in the previous chapter called “CRITICAL! - How to use ModX to avoid messing up your site, and make your life easier; or in other words: Keeping Your Website Organized, Professional, and Up to Date Through What are Called ‘Styles’
Format and Headings 

Let’s first create a heading for our page.  If I am using the “Long title” feature in my pages, then it will automatically create a header at the top of the page.  Otherwise, I can create one here.  Perhaps I want to divide into sub-sections as well.  From the “Format’ menu,  I should use the “Heading 1” for the main heading.  If I need a sub-heading under that, use Heading 2, etc…
Example:  Let’s say I am creating the “’About Our Company” page.  I put on that at the beginning, highlight the text by dragging my mouse over it, and from the “Format” menu, I click ‘Heading 1.”  Next, let’s say that I want to divide the page up into sub-sections.  I could create a subsection that says “How We Got Started” and another section that says “Contact Us,” under which I would put in our company contact information.  After typing these in, I then highlight them and apply the format “Heading 2.”  I could even create sub-sections (Heading 3) such as Phone, Hours, etc…  Ok, maybe this wouldn’t look good, but you get the idea.
Styles
If you remember from earlier, I said that there were certain buttons which you should avoid using, and instead use the “Styles” drop-down.  

Again, if you do not know CSS, your web designer can add more styles to this dropdown menu.  He just needs to define them in the stylesheet, and then in ModX’s configuration, he can list the styles that should be available to you in the editor.

Let’s say you wanted to have a little highlighted text, here and there on your website.  My web designer created a style for me called “Highlight.”  I just need to use my mouse to select the text that I want to highlight, and then select the “Highlight” option from thee “Styles” drop-down.  I have found through experience that if I have other formatting, like bolding, that it works best to apply the “’Style” first, and then the bolding.
Other buttons in the editor

There are a number of buttons that may be new to you in the editor.  I will briefly review the ones that most people might find useful, and/or not self explanatory:

Insert/edit anchor

An anchor is a way to create a link within the same page, which works great for a really long page, such as one that has a table of contents.
Example:  Let’s say I have a really long page with my company’s policies, and I decide to use a short table of contents.  One of the sections could be “Returns & Exchanges,” and another could be “Shipping Policies.”  I could create a table of contents at the top of this page, and use the “Insert/edit anchor” to link the table of contents to each of these sections within the same page.

Paste as Plain Text / Paste as Word

If you must copy directly from Microsoft Word, or other word processor, directly into the ModX editor, then use these.  I can’t promise how well they will work though. Again, as mentioned in a previous chapter, you should avoid copying and pasting from Word as if your website’s life depended on it.
Remove formatting

If you have formatting on something, then this will remove it.  When changing the formatting of something, I highly recommend using this first, to avoid possible conflicts.  

Toggle guidelines/invisible elements

Things like table borders can be transparent on your site, so this lets you see/hide it in the editor to make  it easy for you  to manipulate the table.

Insert custom character

Very handy for inserting a copyright symbol, registered trademark, trademark, etc…
Emoticons

These are not really useful for most of us as they can make a website look silly and corny.

Insert/edit Flash movie

If you have a flash movie (SWF file), then you can upload it here.

Insert / edit embedded media

Same as previous, but for other media files such as audio, video.  Please respect copyright laws.
Insert non-breaking space character

Not really needed
Toggle full-screen

This will give you a little more working area, as this stretches the editor to fill up a little  more space.
The editor is not a “true” web design tool
The editor will let you accomplish basic tasks.  There may be some instances where it cannot do many things.  All website tools such as FrontPage and Dreamweaver are incapable from doing many things that must be done at the HTML code level.  If you did not know already, a website is made up of code we call HTML.  Most people can learn the most essential basics of HTML within a few minutes, to a few hours, depending on how much you want to know http://htmldog.com.  
The most useful things I have found in HTML mode  is being able to enter a single break (spans 1 line), instead of a complete  paragraph break (which spans 2 lines).  A single break in HTML is accomplish with the following: <BR />     The other most useful thing I have found with HTML  and the editor is being able to enter something between two objects that are touching, such as two tables right next to each other.  Not even in Microsoft Word are you able to do this—the HTML mode in the editor can be a real life-saver at times.  
Inserting Links
Inserting a link is quite simple. First you highlight the word(s) that you want to become the link, then right-click on the word, or click the link icon in the editor toolbar.  If you want to link to another website (e.g. external link), then just fill in the “Link URL” field.  If you want to link to another page within your website (e.g. internal link), then just click on “Link List.”  
Now that you know how to make a link, there are some options you may want to use.  If you want to open the page in a new window, (which is probably not very often unless maybe you are linking to other websites), then you can do that using the “Target” field.  You can even create a JavaScript popup (if you don’t know what that is, just try it out if you want to see one).    
“Class” lets you pick a different link style.  Most sites will probably only have 1, or at most, 2 or 3. Additional classes can be created by your web designer.
The “Events” and “Advanced” tabs will not ever be needed by most people.

Inserting Images & Editing Images
Inserting an image is also very similar to using Microsoft Word.  First click in the editor where you want the image to appear.  Then click the “Insert/edit image” icon in the editor’s toolbar.  Click on the small icon to the right of the “Image URL” field.  This will let you browse from all the image files you have uploaded to ModX.  
To upload an image, click the “Upload” button at the bottom of this new file browser window, and select the image on your computer to upload. Click “Upload.”    You can also create additional folders to organize your images if you prefer.   

We highly recommend resizing your images before uploading them to your website since it will be easier, faster, better looking, and save you space on your website.  If you do not optimize the images for your website, many people may not be able to visit your site, and your hosting company could theoretically shut down your website if it is taking too much bandwidth.  To resize your photo, there are many great free programs such as PhotoGadget (very easy, fast, for resizing only), or IrfanView.
Once you have the image uploaded in the image manager, click on it--that's all. Of course, after they are in the image manager, you can use them over and over throughout your website, without uploading them again.
Resizing images using ModX

If you do decide to upload an image without resizing it first, you can actually resize it using ModX.  After uploading the image, you will see a few little icons under each image which allow you to delete, rename, and edit the image.  If you click the resize icon, another window pops open.  You will see familiar image editing tools on the left-hand side.   After performing any of the actions, such as “resize” you need to click the green checkmark at the top to “OK,” or “commit” the action—the red circle cancels  changes.   When you are finished, you need to use the “Save” button on the bottom left.  It will automatically make a copy of your original image, should you decide later to make another version/size of your original image.  You cannot take a small image and enlarge it, and expect it to look good.  You can only make images smaller.
Attaching documents, and files – such as PDF’s
If you need to have a link on your website that people can download a file such as a  Word document, a PDF, a  ZIP file,  an Excel file, etc… you can do this with ModX.  First, in the editor window, type in a phrase such as “Download File.”  Then highlight the word, and make it into a link.  Click the small icon to the right of “Link URL.”  Click the “Browse” button, select the file on your computer, and then click “Open” and then “Upload.”  If I am going to have a lot of files, I can create folders here to keep them organized.  Finally, click on the file, and then “Insert.”
Tables

Creating tables in ModX is much like using Microsoft Word.  Whenever you click on something in a table, you will see the current cell being outlined with little dots.  If you are not seeing the tables being outlines, then click the “Toggle invisible guidelines/elements.”

Right-clicking anywhere in a table will allow you to manipulate your table, such as merging two cells, inserting rows, etc…   Editing tables with an editor can be quite tricky at times.  When all else fails, you can always delete a table and then start over.  I have heard that copying entire tables does not work in every browser (e.g. Firefox).
To delete a table, row, or column, just right-click on the item you want to delete, and then click the appropriate delete button.
You may even need to edit the HTML (or contact your web designer) in some cases when the editor is not doing something you want it to do in  relation to tables.
Other final tips on editing pages (QuickEdit feature)
By default, your ModX is setup to let you do something pretty cool.  As long as you are logged into ModX, you can visit your website, and see some buttons floating on your site.  This quick-edit feature lets you browse your site,  and edit your content from there.  Other people visiting your website will not see these.  I have found that sometimes this gets in I the way, or causes the page design to get messed up (just logout of ModX to be sure that this is the case).
One final note:   It is highly recommended to save often.  There is not an auto-save feature, so if your internet connection has a problem, you could lose any work you did not save.

Deleting / Saving / Publishing a document

When you are finished editing a page, you need to save it, by using the “Save” button at the top or bottom of the page.
You will see the delete button there as well.  After you delete a document, it will still be on the document tree, but with a line through it.  To permanently delete, or purge it from this list, click the trash can icon on top of the document tree, “Purge deleted documents.”
By default ModX may not be configured to automatically publish new pages.  To see if a page is published, open/edit the page you want to check.  You will then see 4 tabs near the top.   Next to ‘General’ you will see “Page Settings.”  From there you can publish (show), or unpublished (hide), pages from your website.  Under Tools > Configuration, you can find a setting to automatically publish all new pages by default.
META Tags

If optimizing your site for search engines is important, then you might find META tags a tiny bit useful—META tags are over-rated by many companies today.  But you can edit the META tags of your pages if you would like.  
This is covered in the full ModX manual, but basically, if you go to the ‘Resources” tab, then “Manage META tags and Keywords,” you can create them here.  To create a META Description, give it  a name (e.g. Home page), and then from the “Tag” field, click “Description,” and then in the “Value” field enter in the META tag.  Click “Add tag.”  
You can also create META Keyword in the Keywords section on that page.  After creating your META tags, you can choose them whenever you are editing a page, on the “META Keywords” tab.
JavaScript and Veracart users

When using the editor, certain things (or elements) may not appear in the editor window.  This includes JavaScript.  For example, if your site uses Veracart, this could apply to you.  If you are comfortable with HTML mode, then you can do it yourself.  What I like to do is to edit it in HTML mode, look for the JavaScript, and then put in a word before and another one after the JavaScript.  Then I get out of HTML mode and I can see the words in the editor window.  That way, I know where the cart will appear in relation to the rest of my content (of course I delete the extra letters when done).

Editing Things That are Part of the Site Design

Some of you may ask, “How can I change something outside the content area, in my site design, such as in the header of my site?”  Your web designer can set this up for you using the “template variable” feature in ModX.  After they have set this up for you, you will see this whenever you edit a page, underneath your main editor window.
Multiple Users and Permissions
I won’t go into detail here, but you can read the official manual for details. Basically you can create additional users and limit their ability to update only certain parts of thee website.
Conclusion
Using it will be the best way to learn it. Again,  we expect our users to participate in the ModX forums for support questions, and to refer to the documentation on the ModX websites for further training.
